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C H A P T E R  1  

Introducing Rhythmyx 
FastForward for Web Content 
Management 

The Rhythmyx Content Management System manages content through the automation of content creation, 
maintenance, and delivery, enhanced with features such as content reuse, delivery to multiple sites, 
intelligent relationships between content, and simple content assembly for business users.  

One of Rhythmyx’s key features is content reuse, which it achieves by separating content and formatting, 
enabling users to create a variety of outputs using the same data. Business users can assemble the same 
Content Items multiple times using different formats and include the Content Items in the output formats 
of other content. This enables Rhythmyx output pages to contain many Content Items assembled together.  

Another key feature of Rhythmyx is its ability to publish content to multiple sites. Rhythmyx allows any 
number of applications to be used to present published content to consumers since the content delivery 
mechanism (a portal, Web server, or other application) is not connected or “coupled” to Rhythmyx. This 
“decoupled delivery” not only offers companies flexibility in choosing delivery applications, but also 
simplifies the process of delivering content to multiple media. 

This document will help implementers get started with Rhythmyx by installing it with its “FastForward” 
sample components and Content Items, starting the Rhythmyx Server, and publishing sample content. For 
more details about content creation, reuse, and delivery, and conceptual information about content 
assembly and intelligent relationships, see the Rhythmyx Concepts Guide.  
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About FastForward 
Rhythmyx FastForward is a reference implementation available with Rhythmyx.  FastForward includes a 
set of pre-built components and applications that allow a company to quickly bring their Web site under 
management. These pre-built components include definitions for the types of content and outputs most 
commonly implemented by customers and elements for setting up typical publishing and authentication 
scenarios. This document includes instructions for installing and reviewing these components. 
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Implementing FastForward 
Install, configure, and implement FastForward in a development environment and then test your features 
in a test environment.  After development and testing is complete, migrate your Rhythmyx components to 
the production environment where your end users perform their work. This process ensures that end users 
only have access to completed, tested components and features. 

Before reading this document, read the Rhythmyx Concepts Guide for a basic understanding of the 
concepts and operation of Rhythmyx.  Then use this to guide you through the process of installing 
Rhythmyx with FastForward and testing that the installation was successful and that it is publishing 
content as expected.  This document also includes a "guided tour" of Rhythmyx functionality.   

After reading this document, use the following documents to guide you through the process of designing 
and implementing your Rhythmyx Content Management System. 

 Modeling and Design of a Rhythmyx Content Management System 

This document outlines the process of modeling your content and designing a CMS 
implementation to meet your needs. 

  Rhythmyx Implementation Guide  

This document explains the common tasks of implementing a Rhythmyx CMS by illustrating 
the implementation of selected elements of FastForward. 

 Setting up the Rhythmyx Production Environment 

This document explains how to set up the production environment and deploy your 
implementation from your development environment to that production environment. 
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C H A P T E R  2  

Installing Rhythmyx in a 
Development Environment 

In the recommended Rhythmyx environment, implementers create new Rhythmyx elements and features 
on a development server, perform user testing on a testing server, and install tested, new functionality to a 
production server.  In technical terms, this is called a multi-tiered environment, and each Server level 
represents a tier. 

 

Figure 1: A multi-tiered environment includes development, testing and production tiers. 

It is important to implement FastForward on a separate development tier and integrate and test completed 
development work on a testing tier. On the development tier, configure Site structures and develop 
Rhythmyx applications and elements.  On the testing tier, integrate all development work and determine if 
it functions as expected. Since features in development and testing states tend to be incomplete and 
unstable, they should never be accessible on the production tier, where users are creating and publishing 
actual content. Once testing is complete, move new components to the production tier. 

A Web Server must be installed on each tier to test or perform publishing. Implementers should 
successfully publish the sample content on the development tier before configuration is deployed to an 
integrated testing tier and then a production tier. 
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Preparing the Development Environment for 
Rhythmyx Installation 
The following guidelines are suggested for installing Rhythmyx with FastForward. The actual resources 
required depend on many factors such as the number of contributors, how frequently content is published, 
and how frequently it is updated. 
 

Server Side 
The Rhythmyx Server must be installed on one of the following supported Operating Systems.  The size 
requirements for both the development and production tiers are noted: 

 UNIX Certified for Solaris  9 or  10  

Development Production 

Processor - UltraSPARC IV (dual core) - 2 GHz UltraSPARC T1 - 1 Ghz 

RAM - 2 GB RAM - 4 GB 

Disk Space - 1.2 GB + 1.2 GB for installation and 
application data 

Disk Space - 1.2 GB + 1.2 GB for installation (and, 
depending on the amount of application data, 2 - 20 
GB more on the server and 2 - 20 GB more on the 
database machine) 

 Windows 2003 (Server and Advanced Server), Windows XP, Windows Vista, Windows 
Server 2008  

Development Production 

Processor - 2 Ghz (dual core) Processor - 3 Ghz (dual core) 

RAM - 1 GB + 1 GB for the database RAM - 3-4 GB (assuming the database is on a 
different system) 

Disk Space - 1.2 GB + 1.2 GB for installation and 
application data 

Disk Space - 1.2 GB + 1.2 GB for installation (and, 
depending on the amount of application data, 2 - 20 
GB more on the server and 2 - 20 GB more on the 
database machine) 

 Linux (Certified on Red Hat Linux AS v4.0 and Red Hat Linux v5.0; Linux OS certified on 
Intel-based hardware.) 

Development Production 

Processor - 2 Ghz (dual core) Processor - 3 Ghz (dual core) 

RAM - 1 GB + 1GB for the database RAM - 3-4 GB (assuming the database is on a 
different system) 
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Development Production 

Disk Space - 1.2 GB + 1.2 GB for installation and 
application data 

Disk Space - 1.2 GB + 1.2 GB for installation (and, 
depending on the amount of application data, 2 - 20 
GB more on the server and 2 - 20 GB more on the 
database machine) 

 

Client Side 
One of the following browsers must be installed to support content contribution, Workflow, and 
Publishing: 

 Internet Explorer V6.0+  

 Firefox 2.0 and 3.0 

 Safari 3.12 (Macintosh only) 
In order to use the Rhythmyx Connector for Word, your browser must be Internet Explorer and your 
system must have one of the following versions of Microsoft Office Client installed: 

 Word 2002/XP or higher  

 Functionality limited in Word 97 
Our applet requires Java JRE 1.5.0_07 on all operating systems except Windows Server 2008, which 
requires Java JRE 1.6.0_7. 

In order for implementers to use the Rhythmyx Workbench, one of the following supported environments 
must be installed: 

 Windows XP Professional  

 Windows 2003 Server Platform 

 Windows Vista 

 Windows Server 2008  
The following hardware is required to use Development Tools including the Workbench: 

 Processor - P4 2.0 GHz or higher recommended  

 RAM - MIN 1 GB recommended  

 Disk Space - MIN 400 MB to run installed product (800 MB during install) 
Rhythmyx supports the following versions and working drafts of standard Web technologies: 

 XML V1.0  

 XSLT V1.0  

 HTML V4.0+  

 XHTML V1.0  

 Velocity V1.5 
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Rhythmyx Repository 
Rhythmyx stores its data in an external relational database.  Your system must include one of the 
supported Databases: 

Oracle 9.2i  

Oracle 10g 

Oracle 11g 

MS SQL Server 2000  

MS SQL Server 2005 

MS SQL Server 2008 

DB2 UDB 8.2  

DB2 UDB 9.1 
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Installing Rhythmyx 
Rhythmyx provides Installers for Windows and Unix.  The following section demonstrates the sequence 
for installing Rhythmyx with FastForward for Windows using an MS SQL database; however, you may 
install with any of the supported databases. You must install your database prior to completing the 
installation steps in this section. 

Use the defaults specified in the installation sequence.  To set up your system to use the defaults: 

 In your repository, define a new schema or database named RXMASTER. During installation, 
you will specify RXMASTER as Rhythmyx’s backend database. 

 If you are currently using port 9992 free it. Port 9992 is the default Rhythmyx Server port. 

You must enter your license number and installation code to install Rhythmyx.  They are located on the 
back of your CD jacket. 
 

Installing Rhythmyx on Windows/SQL Server 
To install Rhythmyx with FastForward for Windows: 

1 Insert your installation DVD. In the Startup folder, double-click on setup.exe, the setup 
program for Windows. 

NOTE:  During installation, the installation wizard may return an error indicating that inadequate disk 
space is available for the installation.  If this occurs, open a DOS prompt, set a temporary directory, 
then run the installation executable from the DOS prompt.  To set a temporary directory, use the 
command set IATEMPDIR=C:\tmp, where C:\temp specifies the temporary directory you want to 
use.  This temporary directory assignment is local to the DOS prompt; it does not override the 
temporary directory specified in your system environment variables.   
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After a few seconds, the Installer displays an introduction screen:   

 

Figure 2: Installation window 

2 Click [Next]. 
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The installation wizard displays the license agreement dialog. 

 

Figure 3: License Agreement 

3 Click the I accept the terms of the License Agreement radio button and click the [Next ] button. 
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The installation wizard displays the Choose Installation Type dialog. 

 

Figure 4: Installation type 

4 Choose New Install and click [Next]. 
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The installation wizard displays the Installation Directory dialog. 

 

Figure 5: Installation directory 

5 The Directory field defaults to C:\Rhythmyx.  If you want to install to a different directory, you 
can enter it in the Directory field, or click the [Browse] button and browse to the location 
where you want to install Rhythmyx.  Once you have defined the directory where you want to 
install, click the [Next] button. 

If the directory does not already exist, the installation wizard will ask if you want to create the 
directory.  Click the [OK] button to create the directory.   

6 Click the [Next ] button. 
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The install wizard displays the Installation Information dialog 

 

Figure 6: Installation information 

7 Enter the license number and installation code, which you can find on the back of the CD 
jacket.  Click the [Next ] button. 
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The installation wizard displays the installation type dialog. 

 

Figure 7: Installation type 

8 Leave Typical selected.  Click the [Next ] button. 
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The installation wizard displays the Repository Database Selection dialog. 

 

Figure 8: Repository database selection dialog 

9 In this example, we choose jtds:sqlserver. You should choose the option in the drop list that 
matches your database. Click [Next]. 
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The installation wizard displays the Repository Database Selection dialog. 

 

Figure 9: Repository database selection 

10 In the Database Server field, enter //localhost (or the name or IP address of the machine where 
the SQLServer database resides if it is not local).  (NOTE:  The jtds driver requires the double 
backslashes (//) in the server specification.  If you have specified a port other than the default 
{1433} for your SQL server installation, you must also specify the port {for example:  
//localhost:1433}.  If you use a SQL Server instance, you must specify the instance as well:  
//localhost:1422;instance=Rhythmyx.)  In the Login ID field, enter the login ID of your SQL 
Server installation (the default user is sa).  In the Password field, enter the password of the 
user used to log in to the database.  Click the [Next ] button. 
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The installation wizard displays the Schema and Database Definition dialog. 

 

Figure 10: Schema and database definition 

11 If you defined a database owner other than the default dbo owner, choose the owner from the 
Schema/Owner drop list.  (In most cases, you can leave the default {dbo} selected.)  In the 
Database drop list, choose rxmaster.  The default name for the datasource configuration used 
to connect to the database is RhythmyxData, but you can change the name if you prefer.  Click 
the [Next ] button. 
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12 The installation wizard displays the Rhythmyx Server Type dialog: 

 

Figure 11: Server Type 

13 Leave System Master as the Rhythmyx Server Type.  The other option (Publishing Hub) is not 
a valid development environment.  Click the [Next] button. 
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The installation wizard displays the Server properties dialog  

 

Figure 12: Server properties 

14 For the purposes of this procedure, we will use the default name (Rhythmyx Server), 
description (Percussion Rhythmyx Server), and port (9992) of the Rhythmyx service.  Click 
the [Next ] button. A warning to use unique ports appears.  Click [No] so the warning does not 
appear again. 
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The installation wizard displays the Pre-installation summary: 

 

Figure 13: Pre-installation summary 

15 Click the [Next ] button. 

The install wizard launches the installation process.  When the installation process finishes, 
the install wizard displays the readme. 

16 Review the readme.  Click [Done] to exit the Installer. 
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Installing Rhythmyx on Solaris/Oracle 
NOTE: Before beginning the Rhythmyx installation, define a schema named rxmaster in Oracle that will 
serve as your Rhythmyx data repository. You must also have a login ID and password for the Solaris and 
Oracle servers. Contact your system or database administrator to obtain the necessary Solaris and Oracle 
accounts. 

IMPORTANT REQUIREMENT: To open the Rhythmyx server installed in a UNIX environment, you 
must install the GNU Compiler Collection (GCC), Version 3.2.2 or higher. You can download GCC from 
www.freeware.com. Install GCC to either /usr/local/lib or /usr/lib; otherwise, you will have to modify the 
environment variable LD_LIBRARY_PATH (for the user account under which Rhythmyx is installed) to 
include the GCC path you use. 

To install Rhythmyx with FastForward on a development Solaris platform with an Oracle backend, using 
the command line: 

1 Create (or have your administrator create) a user in Solaris to install and run Rhythmyx. (If 
you run multiple instances of the Rhythmyx server, create a user for each instance.) The user 
you create must be the owner of all files copied from the CD-ROM; must have read 
permissions on all installer files; and must have execute and read permissions on the following 
files: 

 suite.so 

 SetupConsole.sh 

NOTE: You must log in as this same user to run Rhythmyx and perform upgrades. 

2 Copy the contents of the installation DVD-ROM to the install user's home directory 
(/export/home/username). (You cannot run the Solaris installation directly from the DVD-
ROM. Be sure you include the /resources directory when you copy the files to the target 
machine.  If you do not include this directory, the installation will fail.) 

3 From the install user's home directory, change to the directory containing the Rhythmyx setup 
installation files. 
$ cd rxinstaller/setup 

4 Run the shell script SetupConsole.sh. 
$ sh SetupConsole.sh 

NOTE: If you receive a message about insufficient disk space, create a temporary directory under the 
install user's home directory called tmp.   

$ cd /export/home/username  

$ mkdir tmp 

Then set the temporary directory environment variable used to override the default temporary 
directory used by the installer: 

for csh shells: 

$ setenv IATEMPDIR /export/home/username/tmp 

for Bourne, bash shells: 

$ export IATEMPDIR=/export/home/username/tmp 
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Then run the install script again. 

The InstallShield Wizard is launched and displays the following text.  

 

Figure 14: Installation Introduction 
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5 Press [Enter] to continue.  

  

Figure 15: License Agreement 
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6 Read the portion of the License Agreement that you can see on the page. Continue to press 
[Enter] until you have paged through the entire License Agreement.  

 

Figure 16: Accept License 

7 When you reach the question DO YOU ACCEPT THE TERMS OF THIS LICENSE 
AGREEMENT?, enter Y and press [ENTER] to accept and continue.  

 

Figure 17: Install Type 

8 Since you want to create a new install, enter 1 and then press [Enter].  

  

Figure 18: Installation Directory 
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9 Press [Enter] for to use the default directory. 

 

Figure 19: Create directory prompt 

10 Type OK and press [Enter] to create the directory. 

 

Figure 20: Enter license number and installation code 

11 Enter your license number and press [ENTER].    

12 Then enter your installation code and press [ENTER]. 

 

Figure 21: Installation Type 

13 To install in typical mode, enter 1 and press [Enter] or just press [Enter], since 1 is the 
default installation type. 

 

Figure 22: Repository Database Selection 
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14 Define the type of database you are using. For an Oracle database, enter 2 and press [Enter]. 

15 The installer automatically fills in the name of the server on which you are installing 
Rhythmyx as the default database server. If this is where your database is, press [Enter] to 
continue. If your database is on a different machine, enter the IP address or host name for that 
machine, the port number, and the SID and press [Enter]. Remember to insert the @ sign 
before the IP address or host name. 

 

Figure 23: Login ID and Password 

16 Enter your Oracle login ID and password and press [Enter]. 

The installer displays a list of schemas on your database server. 

 

Figure 24: Select Schema 
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17 Enter the number of the schema that you want to use and press [Enter]. 

You are prompted to enter a name for the datasource configuration: 

 

Figure 25: Provide datasource name 

18 Press [Enter] to accept the default datasource name and continue. 

 

Figure 26: Choose server type 

19 Since you want to install a System Master server, type 1 and press [Enter] or just press 
[Enter] since 1 is the default server. 

 

Figure 27: Rhythmyx Server Properties 

20 Accept the default Port number of 9992 by pressing [Enter].   

The installer prompts you to indicate if you want to customize additional ports. 

21 Type N and press [Enter]. 

The installer displays a warning that all port numbers in the installation must be unique and 
prompts you to indicate whether or not it should continue to show this warning.  

22 Type No and press [Enter] to continue. 
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The installer lists your install folder and the Rhythmyx products that you are installing.  

 

Figure 28: Pre-Installation Summary 

23 Confirm that the information listed is correct, and press [Enter] to continue. 

The installer begins installing Rhythmyx. 

 

Figure 29: Installation messages 

24 Once Rhythmyx is installed, the installer displays the readme text. Read the text on the screen 
by hitting enter when you come to the end of each page, or read the readme.txt file that you 
downloaded from your Rhythmyx CD. 

Post-Installation Steps 
When the installation is complete, follow these steps: 

1 To enable auto-startup of Rhythmyx, run the InstallDaemon.sh script located in the Rhythmyx 
root directory. This script must be run as root. 

2 Source the .profile file to update the environment variables for the current shell. 
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Starting the Rhythmyx Server 
To start the Rhythmyx Server in Windows, in your Rhythmyx root directory, double-click on the file 
RhythmyxServer.exe. A terminal window should open and list the progress of the Server initialization. 
When the terminal window displays the message “Started in...”, the Rhythmyx Server is up and running: 

 

Figure 30: Rhythmyx Server Console 

If you have problems starting the Rhythmyx Server, see Startup (on page 91) in the Troubleshooting 
section of this document. 
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C H A P T E R  3  

Introduction to Content Explorer 

Content Explorer is the default home page Rhythmyx displays when any user logs in to the Rhythmyx 
Content Management System. Content Explorer gives business users access to Content Item 
administration functions such as create, approve, and copy, and gives implementers and administrators 
access to Publishing and Workflow setup screens. 

 

Figure 31: Content Explorer 

The following sections explain how to log in to Content Explorer and summarize the functions of each of 
its tabs. 
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Logging in to Content Explorer 
To log into Content Explorer: 

1 Open one of the supported Web browsers and navigate to http://servername:port/Rhythmyx 
where servername:port describes the location of the Rhythmyx server.  For example, if your 
Rhythmyx Server is named contentmanager and you are using the default port 9992, enter 
http://contentmanager:9992/Rhythmyx.  

Rhythmyx prompts you to log in.  

 

Figure 32: Login Dialog 

2 Enter the User name admin1 and the Password demo, and click [Login]. 

Rhythmyx opens Content Explorer.  The Content tab is selected, and the interface displays all 
five tabs. In the upper-right corner, the Status Box displays the Login User Name, admin1.  
The Roles that the user belongs to do not fit in the available space, but Rhythmyx displays 
those that do with an ellipsis (...) to indicate that the user belongs to more Roles.  
FastForward’s only Locale is US English, so the Status Box does not display a Locale. 

 

Figure 33: Content Explorer 

3 Hold your cursor over the word Admin or click on it. 
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Content Explorer displays all of the User’s Roles: 

 

Figure 34: User Roles 

The Site Folders in your navigation pane should appear identical to those in the Content 
Explorer graphic above. 

 

Content Tab 
In the Content Tab, business users create and modify Content Items and transition them into Workflow 
States. This tab also allows users to actively assemble Content Items as pages or portions of pages and 
preview the results. 

The Content tab appears and functions similarly to the Windows Explorer interface: the left pane displays 
a Navigation Tree and the right pane is a Display pane that lists the contents of the node selected in the 
Navigation Tree. 

 

Figure 35: Diagram of Content Explorer 
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Several of the components labeled on the Content tab graphic above are present in Content Explorer 
regardless of the tab selected.  These components include the Rhythmyx banner, which displays the 
product name, the Session Properties box, which displays the login User Name, Roles, Community, and 
Locale (if the system includes more than one Locale), and  tabs for accessing other pages.  Only the tabs 
for pages that the user may access are visible.  If the user only has access to the Content tab, no tabs are 
visible. 

The Navigation pane includes four main nodes that represent different ways of navigating Content Items: 

 Sites – Provides users with a location for setting up a folder tree that resembles the structure 
of an external site or sites.    

 Folders  – Contains folders that contain sub-folders or Content Items. 

 Views  – Contains views that display content sorted and selected according to predefined 
parameters. 

 Searches  – Contains search queries. 
When a user selects a node in the Navigation Tree, the Display Pane displays it contents.  In the Display 
Pane, users can select a Content Item and right-click to open a menu of options for acting on it. Content 

items in the Display Pane may be preceded by the default icon  or by a custom icon, as in the graphic 
above. 

The Content tab also includes a Menu Bar with drop menus that include the various actions available to 
users in the Content tab. 

To the right of the Menu bar, the Content Path displays the full path of the component selected in the 
Navigation pane. 

For more information about the Content tab, see the online Content Explorer help. 
 

Publishing Design Tab 
The Publishing Design table includes links to pages for configuring publishing infrastructure, including: 

 Sites, and the Content Lists and Editions associated withe each Site 

 Contexts 

 Delivery Types 

 

Figure 36: Publishing Design Tab 
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For more information about the options on this tab, see the Help for the tab, or the following 
documentation: 

 Sites:  "Setting Up the Publishing Site and Basic Navigation" in the Rhythmyx Implementation 
Guide. 

 Content Lists, Editions, and Context: "Configuring Publishing" in the Rhythmyx 
Implementation Guide. 

 Delivery Types:  "Configuring a Delivery Type" in the Rhythmyx Technical Reference 
Manual. 

 

Publishing Runtime Tab 
The Publishing Runtime tab provides the capability of initiating Publishing of an Edition and of reviewing 
the results of all Publishing jobs (whether initiated manually or automatically). 

 

Figure 37: Publishing Runtime Tab 

For details about publishing Editions and reviewing publishing results, see the Rhythmyx Administration 
Manual. 
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Workflow Tab 
A Rhythmyx Workflow is a set of States that a Content Item progresses through during its lifetime. In 
general, Content Items are published after they pass through one or more approval States and reach a 
publish State.  

The following graphic shows how the default Workflow tab appears when FastForward is installed.  Your 
Workflow tab should also display the Simple and Standard Workflows. 

 

Figure 38: Workflow Tab 

For more information about Workflows and the Workflow tab, see the CMS Online Help or the document 
Rhythmyx Implementation Guide. 
 

Admin Tab 
The Admin tab includes links to pages used to administer and maintain the Rhythmyx CMS, including: 

 Console 

This page is used to issue commands to the Rhythmyx server. 

 Variant to Template Migration Tool 

This page is used on systems upgraded from Rhythmyx Version 5.7 or earlier to Rhythmyx 
Version 6.0 or later to migrate XSLT Variants to Velocity Templates. 

 Run RxFix 

This tool should only be used under the direction and guidance of a Percussion Software 
Technical Support Representative. 

 Run Repository Consistency Checker 

This tool should only be used under the direction and guidance of a Percussion Software 
Technical Support Representative. 

 



 

 Chapter 3    Introduction to Content Explorer 41 
 
 

 Scheduled Tasks, Task Notifications, and Task Logs 

For details about maintaining Scheduled Tasks and Task Notifications, and reviewing 
Scheduled Task logs, see the Rhythmyx Administration Manual. 

 

Figure 39: Admin Tab 
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C H A P T E R  4  

Publishing FastForward Sample 
Content 

This section shows you how to publish the content of the FastForward Web Site Enterprise Investments.  
The FastForward publishing configuration is set up to publish the content to the JBoss application server 
installed with Rhythmyx.   
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Publishing the Enterprise Investments Full 
Edition 
To publish the Enterprise Investments Full Edition: 

1 In Content Explorer, click on the Publishing Runtime tab.  

2 Expand the Sites node; under the Sites node, expand the Enterprise Investments node.  Expand 
the Editions node. 

3 Click on EI_Full. 

The edit and view pane displays the Runtime Edition page. 

4 In the menu, choose Start. 

The edit and view pane displays Edition progress data, including the following: 

 Progress bar 

 Start Time 

 Elapsed time since the Edition was initiated. 

 Current State of the Edition 

 Number of Content Items Queued 

 Number of Content Items Delivered 

 Number of Content Items for which publishing Failed 

When the publishing job has completed, the results will be displayed in the Logs.  The result 
should resemble the following screenshot: 

 

Figure 40: EI_Full Edition while Publishing 
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Click the log's Job ID to see the results of the publishing job: 

 

Figure 41: Log for the EI_Full Edition publishing run 

Click on an individual Content id to see its results in the job.  This tool is particularly useful to 
determine why a Content Item failed. 

  
In this example, the Template that was being published did not include any Velocity code.  This error also 
occurs if a binding on the Content Item has an error. 
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Publishing and Reviewing the Corporate 
Investments Site 
A second sample Site, Corporate Investments, is also provided.  To publish this Site, run the Full 
Corporate Investments Edition.  When the publishing job is complete, the view and edit pane should 
resemble the following screenshot: 

 

Figure 42: Corporate Investments Publishing Log 

The URL for the published Corporate Investments Web Site is: 

http://localhost:9992/CI_Home/index.html 
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C H A P T E R  5  

A Brief Introduction to Rhythmyx 

Before proceeding with the tasks of customizing your Rhythmyx FastForward installation, you should 
become more familiar with Rhythmyx and its operations.  This chapter provides a brief walk-through of 
the major functionality of the Rhythmyx Content Management System.  We will add several new Content 
Items to the Enterprise Investments Web site.  We will add this content to a new "Education" subsection 
of the "Investment Advice" section of the Enterprise Investments Web site. 
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A Brief Introduction to Content Explorer 
Begin the walk-through by logging in to Content Explorer.   

To access Content Explorer, start your browser and enter the following URL into the address field: 

http://localhost:9992/Rhythmyx 
This URL assumes that the server is installed locally and that you are using the default Rhythmyx port.  If 
you are accessing the server from a different machine, replace localhost with the name or IP address 
of that machine.  If you chose a different port for Rhythmyx, replace 9992 with your preferred port 
number.  Note too that the URL is case-sensitive, so you must capitalize the "R" in "Rhythmyx.  (The 
case-sensitivity is a characteristic of the underlying Java code used in Rhythmyx.)  If you enter the URL 
using a lowercase "r", Rhythmyx returns a message that A handler could not be found to 
handle the request for (/rhythmyx/.xml). 

When you successfully access the server, your browser displays a login dialog.  Use the user name 
author1 and the password demo to log in to Content Explorer.  (The user "author1" is a default user 
provided by Percussion Software that has authorship rights in Content Explorer.) 

Content Explorer uses a Java applet.  When installing the applet, your browser displays a security dialog.  
Click the [Yes] button to allow the applet to install on your browser. 

When the applet finishes loading, your browser displays the Content Explorer window: 

 

Figure 43: Content Explorer 

 



 Chapter 5    A Brief Introduction to Rhythmyx 49 
 
 

Content Explorer consists of four sections:   

 the banner 

 the navigation pane 

 the content pane  

 the menu bar. 
 

The Content Explorer Banner 
The banner consists of the Rhythmyx logo, the Logout button, and the login information at the far right. 

 

Figure 44: Rhythmyx Banner 

The login information consists of three pieces of data: 

 User:  The name of the user logged in to the system, in this case, author1 

 Roles:  The Roles into which the logged in user has been authenticated.  If you hover your 
mouse over the value of the Roles field, Rhythmyx displays a popup listing all of the Roles 
into which the user has been authenticated.  The value of the Roles field is also a link.  You 
can click on this link to display a popup window with the user's list of Roles as well.  The 
graphics below illustrate both options: 

 

Figure 45: List of user's Roles 

 

Figure 46: Popup with Roles 

 Community:  The Rhythmyx Community into which the user is currently logged.  The 
author1 user is initially logged in to the Enterprise Investments Community, as illustrated in 
the screenshot above. 
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The Navigation Pane 
The Navigation Pane provides you with options for locating and organizing Content Items.   

 

Figure 47: The Content Explorer Navigation Pane as displayed when first accessed 

The Navigation Pane consists of four main Nodes: 

 The Sites node is used to define Site structures and to assign Content Items to those Sites.  
When Rhythmyx publishes the content, it creates a directory structure on the target Web 
server identical to the structure you define under this node.  Published pages are output to the 
directory parallel to the Content Explorer Site Folder to which they have been assigned. 

 The Folders node consists of Folders used strictly to organize Content Items.  The folder 
structures created under this node are not used in Publishing but for personalized organization. 

 The Views node consists of a set of pre-defined queries that return lists of content.  View fall 
into four categories. 

 My Content Views 

This category is the richest set of default Views.  Views in this category list Content 
Items checked out to the logged user, Content Items assigned to the logged user, 
Content Items the user has worked on recently, and Content Items created by the 
user. 

 Community Content Views 

This category consists of Views that list Content Items only in the current 
Community of the user. 

 All Content Views 

This category consists of Views that can list all Content Items in the system, 
regardless of their Community or current Workflow State.   
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 Other Content Views 

This generic category consists of Views that do not fit in any of the other 
categories. 

 The Searches node consists of the New Search query and several pre-defined search queries.  
Searches are somewhat simpler than Views.  Views can query based on system data not 
available to searches.   

For more details about any of these nodes, see the Content Explorer Help, which you can access by 
choosing Help > Content Explorer from the Menu Bar. 
 

The Content Pane 
The larger area to the right on the Content Explorer is the Content Pane.   

 

Figure 48: Content Explorer 

When you initially log in to Content Explorer, the default navigation selection is always the Recent View.  
Since you have not logged in before and have not worked with any Content Items to this point, this View 
has no results, as illustrated in the graphic above, which shows the text "No search results to display". 

Expand the Sites node, and select the Enterprise Investments Folder.  Now the Content Pane lists the 
contents of this Folder.  This Folder includes a number of Subfolders (such as About Enterprise 
Investments, Investment Advice, and Products and Services) and a couple of Content Items (EI Home 
Page and Enterprise Investments Internet Root). 
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The Menu Bar 
The Menu bar separates the banner from the Navigation and Content Panes.   

The Menu bar consists of four menu options and the Content Path.  The Content Path lists the Navigation 
path to the object currently selected in the Navigation Pane. 

The following Menu options are available: 

 Content 

The Content Menu consists of options for managing Content.  This menu includes three 
options: 

 New 

The New Menu consists of two submenus:  New Item and Folder.  The Folder 
option is only available if you are in either the Site or the Folder node, or a 
Subfolder of one of these nodes.  The Folder option allows you to create a new 
Folder.  The New Item option lists all Content Types for which the current user has 
access to create a new Content Item.   

 Search 

This option launches a new Search. 

 <selected Navigation Pane node> 

This name of the selected node in the Navigation pane. Submenu options available 
from this choice include the right-click options for the node. 

 View 

The View Menu includes two choices.  The Refresh option refreshes Content Explorer.  The 
Options choice activates the Display Options dialog, where you can modify the display 
settings for Content Explorer. 

 Help 

The Help Menu includes two options.  The Content Explorer option activates the Content 
Explorer Help.  The About option activates the About Content Explorer dialog. 
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Creating Content Items 
Content Items are the basic units of content in Rhythmyx.  A Content Item is usually a portion of a page, 
such as a block of text, an image, or a banner, header, or footer.  In some cases, such as home pages, a 
Content Item may be a complete page, but more commonly, a Content Item is a portion of a page. 

By defining content in such a granular manner, Rhythmyx provides users greater control over the content.  
You can use the same Content Item in multiple ways on different pages.  Further, if editing is necessary, 
you only need to change the Content Item that needs to be modified, and do not disturb other parts of the 
page.   
 

Creating a Generic Content Item 
Let us begin by creating a simple Generic Content Item.   

You should always create new Content Items in a Folder so you can find them easily.  Rhythmyx does not 
require you to be in a Folder when you create a Content Item, but if you do not create the Content Item in 
a Folder, you will need to search for it or use a View to find it.  We will create our Content Item in a Site 
Folder. 

In the Navigation pane, expand the Sites node, and select the Enterprise Investments Site Folder.  Notice 
that when you select this Folder, the contents of the Folder are displayed in the Content Pane.  Double-
click on the "About Enterprise Investments" Folder.  We will create our new Content Item in this Folder 
for now. 

Percussion Software provides the content for this new Content Item, and several others we recommend 
that you create in the course of this walk-through.  The content is provided in a set of .txt files in the 
<Rhythmyxroot>/Samples/ffsamples directory.  If your Rhythmyx server is on a remote machine, you 
may want to copy the contents of this directory to your local machine.  We are going to use the tuition.txt 
file to provide the content for our example Content Item.  Open this text file in a simple text editor such as 
Notepad. 

To create your new Generic Content Item: 

1 In the Menu bar, choose Content > New > New Item > Generic. 
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Rhythmyx pops up a blank Generic Content Editor: 

 

Figure 49: Generic Content Editor 

2 Change to the Tuition.txt file, and copy the first line.  Change back to Content Editor and 
paste this text in the System Title field.  Paste it again into the Title field. 

3 Note that the Start Date defaults to the current date.  Do not change the value in this field. 

4 Change to the Tuition.txt file and copy the second line.  Change back to the Content Editor 
and paste this text into the Description field. 

5 Click the Callout field to enable it. Change to the Tuition.txt file and copy the third line.  
Change back to the Content Editor and paste this text into the Callout field. 

6 Click the Body field to enable it. Change to the Tuition.txt file and copy the text from the 
beginning of the third line to the end of the file.  Change back to the Content Editor and paste 
this text into the Body field. 

7 Click the [Insert] button.  You will be briefly redirected to a page asking you to wait a 
moment while your Content Item is uploaded to the repository, then redirected again the 
Content Editor. 

You have just added a new Content Item to the Rhythmyx Repository. 

8 Click the [Close] button to close the Content Editor.  Note that the new Content Item, 
"Tuition Tax Credits and Deductions Offer Free Money from the IRS" has been added to the 
Enterprise Investments Folder. 
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9 Right-click on "Tuition Tax Credits and Deductions Offer Free Money from the IRS" in 
Content Explorer.  A menu of options opens.  Move your cursor to Enterprise Active 
Assembly. This option includes a set of links you can use to preview different formatted 
outputs of the Content Item.  For example, if you click the P - EI Generic link, Rhythmyx 
displays a window similar to this: 

 

Figure 50: P - EI Generic Format 

This page illustrates how the Content Item would look as a published Web page.   
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If you click the S - Title Callout Link, you see a window similar to this: 

 

Figure 51: S - Title Callout Link Format 

Both links launch the item in Active Assembly. Active Assembly consists of a two-panel interface that lets 
you edit content items directly on the page. The left panel is referred to as Outline view, and the right 
panel is referred to as Page view. Later in this document, we will complete various tasks in the Active 
Assembly interface. For complete information on Active Assembly, see the Active Assembly Interface 
Help. 
 

Creating a Generic Word Content Item 
Rhythmyx has been designed with enough flexibility that you can connect to third-party tools as Content 
Editors.  One of the most common tools used for creating content is Microsoft Word word processor.  The 
Generic Word Content Type provides the option of entering and maintaining Content Items using 
Microsoft Word.  We will enter Content from the sample Content File SavingForCollege.txt.  You should 
still be in the Enterprise Investments/About Enterprise Investments Folder to create this Content Item 

Note that before you can launch Word from Rhythmyx, you must update your security options.  In Internet 
Explorer choose Tools > Internet Options and click the Security tab: 

 Make your Rhythmyx server a trusted site (Click the [Sites....] button then the [Advanced] 
button. In the Add this web site to the zone... dialog, enter http://localhost (or the name or IP 
address of the remote machine where your Rhythmyx server resides) and click [Add]. Click 
[OK] twice to return to the Security tab. 
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 Click the [Custom level...] button and on the Security Settings dialog, find the Download 
signed ActiveX controls entry.  Select either Enable or Prompt for this option.  

 Refresh the Content Explorer screen. 
To create a Generic Word Content Item: 

1 In the Menu bar, choose Content > New > New Item > Generic Word. 

The Generic Word Content Editor uses an ActiveX control to launch Microsoft Word.  
Percussion Software has signed that this ActiveX control is safe, so click the [Yes] button 
when asked whether you want to run the control  After you click [Yes], Rhythmyx pops up a 
blank Generic Word Content Editor. 

2 Change to the SavingForCollege.txt file, and copy the first line.  Return to the Content Editor 
and paste the first line into the System Title field. 

3 Click the Callout field to activate it. Change to the SavingForCollege.txt file and copy the 
second line.  Return to the Content Editor and paste this text into the Callout field. 

4 Click the Launch Word link. 

Rhythmyx launches Microsoft Word.  Content editing using Microsoft Word requires the use 
of Word Styles to mimic fields in Rhythmyx. These styles are stored in the GenericWord 
template.  The template includes Word macros that convert the styles into Rhythmyx fields 
during the upload process.  You can implement your own Word-based Content Editors.  For 
details see the document Implementing Word in Rhythmyx.   

5 Change to the SavingForCollege.txt file, and copy the first line again.  Switch to the instance 
of Word and paste it.  Notice that the Style for this paragraph is PageDisplayTitle.  The 
content of this paragraph will be entered into that field in the Repository. 

6 Hit the <Enter> key on your keyboard.  The new paragraph has the Style PageAuthor.  In the 
Style drop list in Word, choose the style PageBody  

7 Change to the SavingForCollege.txt file and copy from the beginning of the second line 
through the end.  Paste this text into the Word document. 

8 In the Word button bar, click the Save to Rhythmyx button . 

9 Word displays a File Name dialog.  Enter the text SavingForCollege.  

10 Click [Save]. 

11 Word displays a confirmation dialog: 

 

Figure 52: Confirmation dialog displayed when you have successfully uploaded your Content Item into 
Word 
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12 Click the [Yes] button.  You will return to Rhythmyx, with the Saving For College Content 
Item displayed in the Content Pane.  The Content Item is located as the result of a background 
search; if you do not see it, click the Search Results node in the left pane. 

13 Right-click on the Saving For College Content Item and choose Edit from the popup menu. 

Rhythmyx displays the Saving For College Content Editor. 

14 At the bottom of the Content Editor, you will find links for viewing this Content Item in 
Active Assembly in different formats.  Click on these links to view the formats available for 
the Content Item. 

15 When you have finished, click the [Close] button. 
 

Creating an Image Content Item 
Image Content Items are used to manage graphics used as content on Web pages.   

Note that some graphics are used within the page layout itself.  Examples include company logos and 
spacers used to define page layout.  These graphics, which are referred to as static images, are not 
managed by Rhythmyx, but reside on the Web server so they can be included in the Published pages.   

Content images, however, are managed as Content Items of the Image Content Type.  Once an Image 
Content Item exists in the system, you can use it in any Slot that allows Image Content Types. 

An example graphic (moneyroll.jpg) is included in the FastForward sample directory.  If you are 
connecting to your Rhythmyx server from a remote machine, you might want to copy this file to your 
local machine. 

To create the Image Content Item: 

1 In the Navigation Pane, expand the Enterprise Investments Site Folder, then expand the 
Images Site Folder.  Double-click on the People Folder. 

2 In the Menu bar, choose Content > New > New Item > Image. 
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Rhythmyx displays the Image Content Editor. 

 

Figure 53: Image Content Editor 

3 In the System Title and Title fields, enter Money Roll. 

4 Click the [Browse] button next to the Image field. 

Rhythmyx displays a browse dialog. 

5 Browse to the <Rhythmyxroot>/Samples/ffsamples directory, select the file moneyroll.jpg.and 
click the [Open] button. 

Rhythmyx adds the path and filename you specified (for example, 
C:\Rhythmyx\Samples\ffsamples\moneyroll.jpg). 

6 On the Content Editor window, click the [Insert] button. 
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7 Rhythmyx uploads the file and refreshes the Content Editor window.  Once the window has 
refreshed, the read-only fields Image File Name, Image Mime Type, Height, and Width include 
data. 

8 Click the [Close] button to close the Content Editor 

9 The new Money Roll Image Content Item has been added to the Folder. 

Two additional sample image files are included in the FastForward Samples directory, 
Girllookingatcamera.jpg and taxandglasses.jpg.  Add these as Image Content Items to the same Folder. 
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Working with Site Folders 
As discussed earlier, Folders are the fundamental mechanism Rhythmyx provides for users to organize 
and navigate content. Folders in Rhythmyx are similar to Folders in Microsoft Windows.  The major 
difference is that the folders in Windows are physical directories on the file system. Files in a folder in 
Windows are physically located in that Folder. 

In Rhythmyx, Folders define virtual locations you can use to organize and navigate content.  The Content 
always exists in the Repository, not in the Folders.  The Folders merely contain pointers to the physical 
Content Items stored in the Repository. 

The Navigation Pane includes two roots that contain Folders.  The Sites Root is used to define Site 
structures.  When you publish a Site, Rhythmyx creates a directory structure on the target server parallel to 
the Site Folder structure you have defined under this node.  Note that you can create a several Sites under 
this node, each of which can be published separately.  The Folders Root contains Folders that are used 
more generically for organization.  The Folders under this root are not published.   

Otherwise, Folders function identically regardless of the root to which they belong. 
 

Creating the Education Folder 
We want to create a new subsection (Education) for the Investment Advice section of our Web site.  This 
section will require a new directory to store the Web pages for the new section.  In Rhythmyx, we create 
the new section, and the new directory, by creating a new Folder. 

To create the new Education Folder: 

1 In the Navigation Pane, expand the Enterprise Investments node, and select the Investment 
Advice node. 

2 In the Menu bar, choose Content > New > Folder. 
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Rhythmyx displays the Create Folder dialog. 

 

Figure 54: Create Folder dialog 

3 In the Folder Name field, enter Education.  You can enter a free-form Description if you wish, 
but that is not necessary.  Leave the defaults in all other fields. 

4 Click the [OK] button. 

Rhythmyx adds the new Folder under Investment Advice.   

 

Figure 55: Education folder 

Double-click on the Education Folder.  Rhythmyx displays the contents of the Folder in the Content Pane.  
Notice that this Folder already has a Content Item, Education, of the Navon Content Type.  This Content 
Item is created automatically by the Managed Navigation functionality.  It is used to generate navigation 
for the Web site automatically when it is published.  For more about Managed Navigation see 
Maintaining Managed Navigation for the Education Folder (on page 83). 
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Moving Content into the Education Folder 
Since Web pages are published to the directory corresponding to the Site Folder in which they are located, 
we want to move the Content Items we previously created into the new Folder.   

Let us move the Tuition Content Item first.  To move the Tuition Content Item: 

1 Select the EnterpriseInvestments Folder. 

2 In the Navigation Pane, select the About Enterprise Investments Folder so you can see its 
contents in the Content Pane. 

3 In the Content Pane select the Tuition Content Item, and drag it to the 
InvestmentAdvice/Education Folder (as you drag the Content Item, you will notice a small 
dotted square below the mouse pointer; this square indicates that you are dragging the Content 
Item. 

4 Place the mouse pointer over the Education Folder and release. 

Rhythmyx pops up a dialog with the following options: 

 Move 

 As Link 

 As New Copy 

 
5 Select the Move option. 

The Tuition Content Item is removed from the Content Pane. 

6 Select the Education Folder.  The Tuition Content Item has been moved to the new location. 

 

Figure 56: Education Folder with moved item 
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7 Use the same procedure to move the Saving for College Generic Word Content Item into the 
Education folder. 

8 Now go into the EnterpriseInvestments/Images/People folder and move the Money Roll, Girl 
Looking at Camera, and Tax and Glasses Content Items into the Education Folder. 

 

Adding Additional Content to the Education Folder 
Two additional sample txt files, TenThingstoknow.txt and Section529Plans.txt are included in the 
Samples directory.  Use these to create two more Generic Content Items, "Important Things to Know 
About Saving for College" and "Section 529" Plans in the Education Folder.   

When you have created these Content Items, the Education Folder should resemble the following 
screenshot: 

 

Figure 57: Education Folder 
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Active Assembly 
Now that we have some Content Items, we want to create links between them.  In Rhythmyx, the process 
of creating these links is called Active Assembly.  When you use Active Assembly to link one Content 
Item to another, you are creating an Active Assembly Relationship between the two Content Items.   

Active Assembly Relationships are one category of associations between Content Items.  Rhythmyx 
provides the ability to create a variety of associations between Content Items.  Collectively, these 
associations are known as Relationships.  For more details about Relationships in general, see 
Implementing the Relationship Engine. 

An Active Assembly Relationship defines how one Content Item (referred to as the Dependent) will be 
included in another Content Item (which is called the Owner because it owns the Relationship) when the 
content is published.  Active Assembly is used for one of two reasons: 

 to embed one Content Item into another (typically used for graphics, but occasionally also 
used to embed text from one Content Item into another); 

 to create a link from one Content Item to another (such as a hypertext link between two pages, 
or call to a binary file to be displayed to the user). 

We will perform both types of Active Assembly, adding links between the pages we created and adding 
images to the pages.  
 

Adding Links to Other Generic Pages in the Sidebar Slot 
On the P - EI Generic Template, the Sidebar Slot is used to create links to other Content Items that contain 
content related to the topic on the current page.    Let's create a link from the Tuition Content Item to the 
other new Education Content Items we created. 

To create related content in the Sidebar Slot: 

1 In the Navigation Pane, select the Education Folder. 

2 Right-click on the Tuition Content Item and choose Enterprise Active Assembly > P -EI 
Generic from the popup menu. 
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Rhythmyx displays the P - EI Generic format of the Tuition Content Item in the Active 
Assembly Interface. 

 

Figure 58: Tuition item in P - EI Generic format 

In Active Assembly, you can modify the Snippets in the Slots on this Template. 

3 In Outline View, find Sidebar slot, and right-click the  icon, and choose Insert Snippet 
from the drop menu.   
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Rhythmyx displays the Content Browser.   

 

Figure 59: Content Browser 

4 Click the Search tab. 
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Two versions of this tab are available.  If you are using the full-text search engine, you will 
see: 

 

Figure 60: Content Browser, Search Tab 
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If your system is using the database search engine, you will see: 

 

Figure 61: Content Browser, Search tab 

5 If you are using the Full-text Search engine, enter college into the Search for field.  If you are 
using the database search engine, enter college into the Title field.  Click the [Search] button. 
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6 Rhythmyx returns the Search results: 

 

Figure 62: Search results 

7 We want to insert the Section 529 College Savings Plans content item, so we click it. 

A page that lets us choose the Template or format for the content item opens. It lists five 
Templates with which we can format the item: 

 S - Callout 

 S - Image Link 

 S - Title Callout and More Link  

 S - Title Callout Link 
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 S - Title Link 

 

Figure 63: Template selection page 

8 Click each option under Select a template to see in Template Preview how it formats the 
content item.  

We want to create a link to the specified page using the Title and Callout of the target Content 
Item, so we will use the S - Title Callout Link Template. 

9 Select S - Title Callout Link and click [Select]. 
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The Content Browser returns to the page of search results so you can add another item to the 
Slot.  If you move the Content Browser over so you can see the Sidebar Slot where it appears 
in Page view, you will see that the Section 529 College Savings Plans content item has been 
added to the Slot.   

 

Figure 64: Snippet added to Slot 

10 Repeat Steps 7 - 10, adding the Important things to know about saving for college content 
item in the format of the S - Title Callout Link template.   

11 When you return to the Search results, click [Back] to return to the search screen. Since you 
do not want to enter another search, click [Close]. 

The Content Browser closes and the page for the Tuition Content Item now resembles: 

 

Figure 65: Sidebar Slot with two Snippets added 
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When you begin with an empty Slot, each new Snippet that you add to the Slot with the 
Content Browser is inserted at the bottom of the Slot, so the Important things to know about 
saving for college Snippet appears below the Section 529 College Savings Plans.  

Each of the titles in the Snippets that you have added is a link to the Web page for that item. 
To see this press ALT and click on one of the Snippet titles. 

Rhythmyx opens the page that the title links to. 

12 When you have finished, close the Active Assembly window for the Tuition Content Item. 
 

Adding an Image to a Generic Page 
Now let us add an image to one of our Education Content Items.  In this case, let us add an image to the 
rich-text Body field of the Content Item. 

1 In the Navigation Pane, select the Education Folder. 

2 In the Content Pane, right-click on the Tuition Content Item and choose Edit from the popup 
menu. 

Rhythmyx displays the Tuition Content Editor. 

3 Scroll down to the Body field, and place the cursor before the first character in the field. 

4 Click the Insert Rhythmyx Image button . 

Rhythmyx displays the Content Browser.  

5 Click the Search tab. 
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Two versions of this tab are available.  If you are using the full-text search engine, you will 
see: 

 

Figure 66: Content Browser, Search Tab 
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If your system is using the database search engine, you will see: 

 

Figure 67: Content Browser, Search tab 

6 If you are using the Full-text Search engine, enter glasses in the Search for field.  If you are 
using the database search engine, enter glasses in the Title field.  Click the [Search] button. 

Rhythmyx returns the search results. 

7 We want to insert the Tax and Glasses content item, so we click it. 

A page that lets us choose the Template or format for the content item opens. In this case, 
there is only one Template available for the item: 

 B - Image 

8 Select B - Image and click [Select]. 

The image is added to the Body text. The Content Browser closes.  

9 Now let us format the graphic so it merges more smoothly with the text.  Click the graphic. 

A black border appears around it. 

10 Right-click on the graphic and choose Image Properties from the popup menu. 

Rhythmyx displays the Image Properties window. 

11 In the Alignment drop list, choose Left. 

12 Click the [OK] button. 
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13 The text will now flow around the graphic, similar to the following screenshot: 

 

Figure 68: Graphic with text flowing around it 

14 Click the [Update] button to upload the changes to the Repository. 

When the changes have been uploaded, the Content Editor will refresh.   

15 Click [Close]. 

Now, add the Money Roll Image to the 529 Content Item and add the Girl Looking at Camera Image to 
the Important Things... Content Item.  You may want to try alternative formatting for these images (for 
example, aligning right instead of left). 
 

Previewing the Content Item 
Now that we have added Snippets to the Slots in our Content Items, let us preview them to see how they 
will look when published.   

To preview the Tuition Content Item: 

1 In the Navigation Pane of Content Explorer, open the Education folder. 

2 Right-click on the Tuition Content Item and on the popup menu choose Enterprise Preview > 
P - EI Generic. 
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3 Rhythmyx displays a preview of the Tuition Content Item. 

 

Figure 69: Preview of Tuition content item 

Note that the page includes the graphic and the content items in the Sidebar Slot that we added.   

Click on the Important Things or Section 529 content item.  Rhythmyx displays previews of these pages.  
These previews give you an idea of how the pages will look when published.  Note, however, that when 
content is published, the Snippets in the Slots will only be included if they are Public.  The following 
section, which describes Workflow, explains how to make these new content items Public. 
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Workflow 
A Workflow is a business process that defines the life cycle of a Content Item.  In Rhythmyx, every 
Content Item must exist within a Workflow.  The Workflow defines: 

 the steps or stages in the processing of the Content Item; 

 which users can access the Content Item at a particular point in its life cycle; and 

 what different users can do to the Content Item at each point. 

Rhythmyx defines a Workflow as a series of stages, or States, which define the life of the Content Item.  
In each State, users in specific Roles have access to the Content Item.  Users in some Roles can modify 
the Content Item, while users in other Roles can only see and read the Content Item.  Users with the 
correct access can also Transition Content Items, moving them between States in a Workflow. 
 

Check In and Check Out 
The check in and check out functionality in Rhythmyx allows multiple users to have access to all Content 
Items, but prevents more than one user at a time from modifying a Content Item.  When a user checks out 
a Content Item, only that user can edit the Item; it is unavailable to all other users.   

Check in and check out are special types of Transitions.  Check in and check out do not move a Content 
Item from one State to another, as do normal Transitions.  Instead, check in sets a lock flag that indicates a 
user has the Content Item checked out.  Check in removes this flag. 

In many cases, Rhythmyx checks Content Items in and out automatically.  In a few cases (notably when 
initially creating a Content Item or after modifying the Content Item), you must check the Item in 
manually. 
 

About Roles 
A Role is a collection of users with the same access in Rhythmyx. In Workflows, Roles determine which 
users can access content in each State and which Transitions they can apply.  

Organizing users into Roles helps administrators manage users that have the same permissions. Instead of 
managing the permissions for each user, they define a Role its permissions, then assign users to it.  Users 
inherit their access rights from the Roles to which they are currently assigned. 
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About the Standard Workflow 
The Generic Page Content Type uses the Standard Workflow, one of two basic Workflows included with 
FastForward.  The Standard Workflow is a common structure that requires one approval before going to 
Public.   

 

Figure 70: Preview of Standard Workflow 

Note that the Standard Workflow includes a Pending State between the Review and Public States.  This 
State is included to support internationalized systems.  In some cases, internationalized systems require 
that Translations of Content Items be Published at the same time as the original.  The Pending State 
provides a holding area" for original Content Items while waiting for the Translations to be completed. 

The Public State is the State in which the Content Item is eligible to be Published.  When a Content Item 
reaches this State, it will be published the next time the Publisher runs. 
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The Quick Edit State is provided to allow quick touch-ups to Content Items without forcing them through 
the complete Workflow again.  For example, if you find a misspelling or minor grammatical error on the 
Content Item, there is usually no need for it to go back through the complete approval process.  Instead, 
you can move it to Quick Edit, make your change, and return the Content Item to Public immediately.  
Note that your changes will not be reflected in the published output until the Content Item is re-published.   

Finally, the Archive State provides a terminal State for Content Items after they have expired.  The 
Content Items continue to exist in the system, and if necessary can be revived.  (In the Standard 
Workflow, revised Content Items are returned to the Draft State and must go through the complete 
Workflow before they can return to Public.) 
 

Transitioning Content Items to a New State 
Now that we have finished creating our Content Items and adding related content, we want to make them 
Public so we can publish them.  We will need to perform Transitions on the Content Items. 

To Transition the Tuition Content Item: 

1 In the Navigation Pane, go to the Education Folder. 

2 Right-click on the Tuition Content Item and on the popup menu, choose Workflow > Submit. 

3 Rhythmyx displays a Workflow Comment window.  You can enter a free-form comment in 
this window. 

 

Figure 71: Workflow Comments Popup 

4 Click the [OK] button to continue making the Transition. 

5 Rhythmyx displays a message box informing you that it is processing the Tuition Content 
Item. 

6 When the message box disappears, the Transition is complete, and the Content Item is now in 
the Review State. 

Note that the Author1 user does not have rights to Transition the Content Item in the Review State.  If you 
right-click on the Tuition Content Item now and choose Workflow, the submenu lists No Entries. 

Repeat the process above for the remaining new Content Items (Important Things to Know, Section 529 
Plans, Money Roll, Tax and Glasses, Girl Looking at Camera, Saving for College). 
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Moving Content Items to Public 
As we noted above, when logged in as Author1, you cannot transition the Education Content Items from 
the Review State.  You must log in as a user with rights to Transition the Content Items in this State.  In 
this case, the user Editor1 has these rights.  Start a new browser session and log in as Editor1 (this user 
uses the standard password demo). 

(Note that you must start a new browser session.  While you can change the Community [and in 
internationalized environments, the Locale] of the user in the current session, each session is associated 
with a specific user.  In order to log in as a different user, you must start a new browser session.) 

Once you have logged in, go to the Education Folder. 

We are going to assume for our purposes that these Content Items are all ready to go Public.  Rather than 
Transition them individually, we can Transition them all at once.   

To Transition multiple Content Items: 

1 Select the Content Items you want to Transition.  In this case, we want to Transition all the 
Generic Page Content Items, the Generic Word Content Item, and the Image Content Items.  
The Content Explorer applet supports multi-select.  You can hold down the <CTRL> key 
while selecting Content Items, or if multiple Content Items are adjacent, select the first 
Content Item, then hold down the <Shift> key while selecting the last Content Item you want 
to select.  All Content Items in between will be selected as well. 

2 Right-click and from the popup menu, choose Workflow > Approve. 

When you multi-select, Content Explorer displays only the Transitions that all selected 
Content Items have in common.  In this case, the Content Items should have the following 
Transitions in common: 

 Check-out 

 Approve 

 Rework 

If the selected Content Items have no Transitions in common, when you select Workflow 
from the popup menu, the submenu option will be No Entries. 

3 Rhythmyx displays the Workflow Comment window.  If you enter a comment in this window, 
it will be added to the record for all selected Content Items.  You cannot enter different 
comments for different Content Items in the selection.  If you want to enter different 
comments for different Content Items, you must Transition them individually. 

4 Click the [OK] button. 

Rhythmyx displays a message window showing the Content Items it is Transitioning.  When 
the message window disappears, all selected Content Items have been Transitioned. 
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The selected Content Items are now in the Pending State.  Ordinarily, when using the Standard Workflow, 
you would allow Rhythmyx to move the Content Items to Public automatically using the Aging 
functionality.  In the Standard Workflow, an Aging Transition has been added from the Pending State to 
the Public State.  This Transition will automatically move the Content Items to Public based on the 
System Field Start Date.  Recall that we preserved the default Start Date, which is the current date, when 
we created our Content Items.  When the aging process on the Rhythmyx server (known as the Aging 
Agent) runs, it will find our Content Items, and note that their Start Date is the current date (or the past 
date when you created them).  Thus, it will move the Content Items to Public automatically.  The Aging 
Agent runs every ten minutes, so you may have to wait a few minutes for your Content Items to Transition 
automatically. 

If you don't want to wait, another Transition, Force to Public, is also available from the Pending State.  
The Force to Public State is only available to users in the Admin role, so if you want to force these 
Content Items to Public, you will have to start another browser session and log in as admin1 to have 
access to Transition these Content Items. 
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Maintaining Managed Navigation for the 
Education Folder 
Recall that when we created the Education Folder, Rhythmyx automatically created a Navon Content Item 
of the same name in the Folder. Navons are Content Items, and act like other Content Items in the system.  
They include Slots and have related Content Items assigned to them.  Navons also exist in a Workflow and 
can be Transitioned.  During assembly, however, Navons are treated somewhat differently.  Rhythmyx 
uses them to create a background XML document that it uses to apply navigation to published pages.   

To ensure that our Education Folder and its content are published correctly, we will need to assign a 
Content Item to the Landing Page Slot of the Education Navon, and we will have to make the Navon 
Public. 

Note that although the users author1 and editor1 can see the Education Navon, this Content Item actually 
exists in the Enterprise Investments Admin Community.  Since the users author1 and editor1 are members 
of the Enterprise Investments Community, they cannot access the Education Navon.  The user admin1, 
however, can log in to the Enterprise Investments Admin Community and thus can maintain this Content 
Item. If you still have a browser session for the admin1 user active, you can use that session.  Otherwise, 
you will need to start a new browser session and log in as admin1.   

Regardless of whether you use an existing browser session or log in to a new session, you will need to 
change the Community admin1 is logged in to from Enterprise Investments to Enterprise Investments 
Admin.   
 

Creating a Landing Page for the Education Folder 
A landing page is the page you are directed to when you click on a link in the Navigation part of a 
Rhythmyx page.    

You must specify the landing page. 

To add a Landing Page to the Education Navon: 

1 In the Navigation Pane, go to the Education Folder. 

Navons generally act like normal Content Items in the system, so they include Slots.  
However, during assembly, Navons are used to create a background XML document that is 
used to add navigation to published pages.  They are never assembled into Snippets or Pages.  
Therefore, you cannot use the Active Assembly Preview to maintain the Slots on a Navon.  
You must use the Active Assembly Table Editor to add related content to the Slots on a 
Navon. 

2 Right-click on the Education Content Item and on the popup menu, choose Active Assembly 
Table Editor. 
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3 Rhythmyx displays the Active Assembly Table Editor. 

 

Figure 72: Navon Table Editor 

4 Click the nav_landing_page link. 

5 Rhythmyx displays the Content Browser. 

6 Click on the Search tab. 

7 Search on the term "tuition". 

8 Click the Tuition content item. 

The Select a Template window opens.  The only option is the S - Title Link Snippet. 

9 Click [Select]. 
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10 The Tuition Content Item is added to the Nav Landing Page Slot on the Table Editor. 

 

Figure 73: Landing Page Added 

11 Close the table editor. 

To see how the landing page works, Preview the Enterprise Investments Home Page, which is located in 
the Enterprise Investments top folder.  In the left navigation bar, Education has been added as a section 
under Investment Advice. Click on this link to go to the Tuition Tax Credits page, which includes links to 
the Education Content Items we added. 
 

Making the Education Navon Content Item Public. 
Before our new Education section can be published correctly, we need to make the Education Navon 
Public.  

Use the same procedure that you used to Transition the other Content Items.  Notice that when you choose 
Workflow from the popup menu, the submenu includes the option Direct to Public.  We will not be 
making any additional changes to the Education Navon, so use this Transition. 

When you are finished, all of the Content Items in the Education Folder, including the Education Navon, 
will be Public.  Now you are ready to publish this Site with the new Section. 
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Publishing the Web Site with the Education 
Section 
Now that we have added our new section, we are ready to publish the Web Site to include it.  If you are 
not still logged in as admin1, log in as the admin1 user. 

To publish the Site, repeat the procedure described in Publishing the Enterprise Investments Full Edition 
(on page 44).     

In Content Explorer, choose the Publishing Runtime tab.  Expand the Sites node, and under that node, 
expand the Enterprise Investments node.  Under that node, expand the Editions node and click on the 
EI_Full Edition.  In the Menu bar, click Start.   

If the new content was published successfully, when you go the Publishing target location (by default:  
<Rhythmyx root> \AppServer\server\rx\deploy\EI_Home.war\) you will see the new 
Education subdirectory in the Investment Advice directory.   

 

Figure 74: Published Education Folder 

If you do not see this directory, none of the Content Items in the Site Folder were published.  If you do not 
see a specific Content Item, it was not published.  Review the log for these Content Items to determine 
why they were not published.  The most common reason for Content Items not to be published is that they 
are not in a Public State.  Go back to the Content tab of Content Explorer and Transition all of the Content 
Items in the Education Folder to Public. 
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Another reason that the Education directory might not be created is that it does not contain any Content 
Items.  Go back to the Content tab of Content Explorer and move the Education Content Items to the 
Education Folder.   

If you open the Education directory, you will see four new HTML pages.  The names of these files will be 
itemNNN.html.  The value of NNN will be the Content IDs of the Generic Page and Generic Word 
Content Items you created during this walk-through.  You will also see three new JPG pages. These are 
the image Content Items that you created. The values should resemble those in the graphic below: 

 

Figure 75: Contents of Education Folder 

If any of the Content Items you created are missing, either they are not Public or they are not in the 
Education Folder. 

If you access the home page by entering http://localhost:9992/EI_Home/index.html, and then click the 
Education link in the right navigation pane, your Tuition page will resemble the following: 

 

Figure 76: Published Tuition content item 
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C H A P T E R  6  

Troubleshooting 
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Installation 

Installer Cannot Connect to the Repository 
This indicates improper entry of the Server’s IP, User ID, or Password.  

Solution: 

For SQL Server, follow the next few steps to establish a connection: 

 Confirm the existence of the sa account through Microsoft’s Enterprise Manager Utility. 

 Confirm, and if necessary, change, the sa password. 

 Re-attempt connection to the Server.  If it still fails, confirm the port on which SQL Server is 
listening in Enterprise Manager: 

a) Select Tools > SQL Server Configuration Properties.  

The SQL Server Properties dialog opens to the General tab. 

b) Press the [Network Configuration] button. 

The SQL Server Network Utility dialog opens to the General tab. 

c) Highlight the TCP/IP protocol and press the [Properties] button. 

The Network Protocol Default Value Setup dialog opens.  

 

Figure 77: Network Protocol Default Value Setup dialog 

d) If the port number listed is not 1433, change it and press [OK]. 

e) Exit Enterprise Manager and restart SQL Server. 
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Startup 

Server Shuts Down During Initialization 
Server encounters an error and shuts down during initialization 

Solution: 

Go to <Rhythmyx root>\AppServer\server\rx\log.  First open boot.log and look for error messages giving 
you details about the server shut down.  If you still need more information, go to server.log and read 
through any error messages. 
 

Rhythmyx License Period Expired 
On startup, the Rhythmyx Server displays the message, “The evaluation period for this license has 
expired.” 

Solution: 
This error indicates that your license for Rhythmyx has expired, and you need a new license.  Contact 
Percussion Technical Support for a new license and for instructions about updating your installation. 
 

Out-of-Memory Condition Displayed on Rhythmyx Startup 
The Rhythmyx Server console displays an out of memory condition when you attempt to start Rhythmyx. 

Solution: 
Start the Rhythmyx Server from a command line and specify at least 512 megabytes of RAM.  

In Windows, use the  following case-sensitive command: 

RhythmyxServer.exe –Xmx512m 

In Unix, create a file named RhythmyxServer.ja. In the file, include the line: 

-Xmx512m 

Run RhythmyxServer on a command line.  The command will automatically check for additional options 
in the RhythmyxServer.ja file and include them. 
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